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Chapter 1 

About AppsAccess  

AppsAccess detects segregation-of-duties conflicts within an organization, either 
preventing them from occurring or uncovering them so that they can be properly 
managed. Designed for use with Oracle Applications, AppsAccess identifies conflicts 
at both the responsibility and function levels.  

AppsAccess users create “conflict rules,” each of which specifies two responsibilities 
or functions that should not both be assigned to an individual person. Users may cre-
ate rules one at a time in a form called the Conflict Matrix, or upload already-created 
rules from an Excel spreadsheet and adapt them as needed.  

Each conflict rule applies one of four “control types” — Prevent, Allow with Rules, 
Allow with Rules (with Approval), or Approval Required. These determine the action 
to be taken when an Oracle Applications user is assigned duties that violate a conflict 
rule: 

• A Prevent rule denies access to conflicting responsibilities or functions. When a 
user is assigned responsibilities that trigger a Prevent rule, AppsAccess sets their 
end dates to match their start dates, thus ensuring there is no period during which 
the user has access to conflicting elements. 

• An Allow with Rules conflict rule permits access to conflicting responsibilities or 
functions if one or more additional rules, written in LogicalApps AppsForm, mit-
igate the conflict by modifying Oracle Applications forms. This control type (like 
the Prevent type) requires no approval, and does not send approval requests to 
reviewers. 
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• An Allow with Rules (with Approval) conflict rule also permits access to conflict-
ing responsibilities or functions on condition that one or more AppsForm rules 
mitigate the conflict by modifying Oracle Applications forms. In this case, how-
ever, the rule designates a reviewer to whom AppsAccess sends an approval re-
quest, and access to the conflicting entities is granted only if the reviewer 
approves.  

• An Approval Required rule designates a reviewer who can either accept a conflict 
(that is, allow an Oracle Applications user to work at responsibilities or functions 
that are known to be in conflict) or reject it. In this case, no AppsForm rule is at-
tached to the conflict rule, and for access to be granted to conflicting responsibil-
ities or functions, no condition need be met other than that the reviewer approve 
the conflict. 

Once conflict rules are defined, an AppsAccess user “generates conflicts” — causes 
AppsAccess to evaluate current Oracle Applications users and note those who are in 
violation of conflict rules. AppsAccess then lists the conflicts generated by each rule 
in a form called User Conflicts. It treats these conflicts in either of two ways: 

• A user may have been assigned responsibilities or functions before a rule was cre-
ated to define them as conflicting. If so, the User Conflict form displays appropri-
ate status for the conflict: “Prevent” or “Allow with Rules” if the conflict was gen-
erated by a rule of either type, or “Pending” if it was generated by an Allow with 
Rules (with Approval) or Approval Required rule. Only the Pending status can 
be updated: a reviewer may approve or reject the conflict, either by itself (in a 
User Conflict Actions form) or along with others (in a Mass Update User Con-
flict form). 

Decisions made in these forms, however, do not take effect; instead, they are 
logged to AppsAccess reports. Administrators would then use information from 
the reports to undertake “cleanup” — to make adjustments in Oracle Applica-
tions such as end-dating responsibilities assigned to users affected by conflicts, or 
excluding a function from a responsibility in which it conflicts with another 
function. 

• A user may have been assigned responsibilities or functions after a rule was cre-
ated to define them as conflicting. In this case, AppsAccess automatically applies 
end dates if the control type is Prevent. If it is Allow with Rules, AppsAccess auto-
matically removes end dates if at least one AppsForm rule has been associated with 
the conflict rule (but applies end dates if not).  

If the control type is Allow with Rules (with Approval) or Approval Required, 
the responsibility assignment does not take effect immediately, and AppsAccess 
posts a notification of the conflict to the designated reviewer’s Oracle Applica-
tions home site. Similarly, when a new user is created, his assignments are ana-
lyzed for conflicts, and notifications are transmitted to designated reviewers. 

The reviewer’s response to this notification updates responsibility end dates for 
the affected user: For an approval, the end dates are removed, permitting indefi-
nite access to the conflicting elements. For a rejection, the end dates are made to 
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match the start dates, preventing any access. Moreover, the user’s status is updated 
in the AppsAccess User Conflicts form. 

The following diagram illustrates the process: 

 
Three AppsAccess reports provide information for the resolution of conflicts: The 
Conflict Summary Report shows the number of conflicts generated for each respon-
sibility and so helps in establishing resolution priorities. The Responsibilities with Con-
flicts Report lists the conflicts within each responsibility. The User Conflicts Report 
presents data generated when conflicts are approved or rejected in the User Conflict 
Actions form.  

Two remaining reports are useful for auditing: The Conflict Matrix report lists 
conflict rules and, for each rule, displays the values that define it. The Application 
Conflict Report provides status information about each user affected by each rule. 

Conflict Matrix Forms 
AppsAccess separates the authority to create conflict rules from the authority to 
approve or reject conflicts generated by those rules. To do so, it provides two copies 
of the Conflict Matrix form: 

• In a copy of the Conflict Matrix labeled Define Conflict Rules, users can create 
rules, generate conflicts, and review them. This copy of the Conflict Matrix, how-
ever, blocks access to the forms in which conflicts are approved or rejected. 

• In a copy of the Conflict Matrix labeled User Conflict Approval, users can view 
conflict rules and review conflicts. They can select options that open the User 
Conflict Actions and Mass Update User Conflicts forms, and then use those forms 
to approve or reject conflicts. In this copy of the Conflict Matrix, however, users 
cannot create conflict rules. 

Starting AppsAccess 
To start AppsAccess: 

1 Select the LogicalApps AppsRules responsibility from the Application list. 
(Ensure first that the AppsRules responsibility is available to you.) 



Chapter 1: About AppsAccess  

4 User’s Guide: AppsAccess 6.5.8 

2 In the LogicalApps Navigator, select either of two AppsAccess options: 

• Click on AppsAccess — Define Conflict Rules to open the copy of the 
Conflict Matrix in which rules are created but conflicts cannot be approved 
or rejected. 

• Click on AppsAccess — User Conflict Approval to open the copy of the 
Conflict Matrix that permits the approval or rejection of conflicts but does 
not allow the creation of conflict rules. 

3 Click on the Open button in the LogicalApps Navigator. 

Finding Conflict Rules 
When you open either copy of the Conflict Matrix, a Find Conflict Rules form 
appears.  

 
You can use this form to load existing conflict rules into the Conflict Matrix. To 
search for all rules, simply click on the Find button. Or to search for a selection of 
rules, complete the following steps. 

1 Fill any combination of the following boxes.  

• Conflict Rule Name: From the list, select a rule to search for it. An entry in 
this field causes AppsAccess to return only the single rule that matches the 
rule name. Or leave the field blank to search among all rules; doing so may 
return any number of rules (depending on the remaining filter selections.) 

• Application: From the list, select an Oracle application to find rules involving 
that application (as either of two applications to which conflicting responsi-
bilities or functions may belong). Or leave the box blank to see rules involving 
any application. 

• Entity Type: Select Function or Responsibility to find rules defining conflicts 
in one entity or the other, or leave the box blank to see rules for both types. 

• Entity: From the list, select a function or a responsibility to search for rules 
involving that entity (as either of the two conflicting entities). Or leave the 
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box blank to search for rules involving any function or responsibility. The 
values you can select depend on your selection in the Entity Type box.  

• Reviewer: From the list, select a workflow role to find rules for which that 
role is the designated conflict reviewer. Or leave the box blank to see rules for 
which anyone is a designated reviewer. 

• Approval Group: From the list, select the name of an approval group (as con-
figured in LogicalApps AppsFlow) to find rules for which that group is the 
designated conflict reviewer. Or leave the box blank to see rules for which 
any (or no) group is a designated reviewer.  

• End-Dated Conflicts: Select Y (for yes) to find rules for which conflicts are 
end-dated or N (for no) to find rules for which conflicts are not end-dated. 
Or leave the box blank to search for both types of rule. 

• Conflicts Exist: Select Y (for yes) to find rules for which conflicts exist or N 
(for no) to find rules for which no conflicts exist. Or leave the box blank to 
search for both types of rule. 

• Same OU: Select Y (for yes) to find rules that apply within operating units or 
N (for no) to search for rules that apply across operating units. Or leave the 
box blank to find both types of rule. 

• Same SOB: Select Y (for yes) to find rules that apply within sets of books or 
N (for no) to search for rules that apply across sets of books. Or leave the 
box blank to find both types of rule. 

• Control Type: Select any combination of check boxes for control types — 
Approval, Prevent, Allow with Rules, or Allow with Rules (with Approval) 
— to search for rules of those types. Select all four check boxes, or clear all 
four of them, to search for rules of all types. 

2 Click on the Find button. (Or, to discard the filtering selection you have made 
and start over, click on the Clear button.) 

After being used, the Find Conflict Rules form remains open in the background. To 
bring it to the foreground and use it again, click on it (drag any other forms, such as 
the Conflict Matrix, out of the way). If you close it, you can reopen it: Click on View 
in the menu bar, then Find in the View menu. Or, click on the Find icon, located 
second from the left in the tool bar. (It looks like a flashlight.) 

Making Selections in AppsAccess 
When you click in a list of values box to enter data, AppsAccess presents a list icon 
to the right of the box. It looks like an ellipsis: 
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When you click on this icon, AppsAccess opens a window in which you can produce 
a filterable list of values that may be entered in the box: 

 
To use this window: 

1 Click in the Find box and type a string of characters for which AppsAccess 
should search. You can use the percent sign (%) to stand for any string of char-
acters. For example, the string AKD would return all entries that begin with those 
letters, while the string %AKD would return all entries in which those letters 
appear in any position. The percent sign alone would return all possible entries. 

2 Click on the Find button. AppsAccess returns a list of the items that match your 
search criteria. 

3 Scroll through the list and click on the item you want. 

4 Click on the OK button. 

 

 



 

User’s Guide: AppsAccess 6.5.8 7 

Chapter 2 

Defining Conflict Rules  

The AppsAccess Conflict Matrix enables you to create new conflict rules; as an 
alternative, you can upload already-created rules from an Excel spreadsheet. In the 
Conflict Matrix, you can also view existing rules as well as generate user conflicts that 
the rules define.  

As you create (or upload) rules, you may consider limiting their number (or at least 
the number that are active), so that the number of conflicts they generate is not over-
whelming. A typical strategy is to start with a set of rules that define what you deter-
mine to be the most important conflicts, then clean up those conflicts before moving 
on to another set of rules. See “Managing Cleanup” on page 27. 

Outside of the Conflict Matrix, you can complete other tasks related to conflict-rule 
definition. One is to create “global subscribers” — to identify data groups, submenus, 
operating units, or users who are exempt from conflict rules. Another is to configure 
workflow roles; you must assign one to each conflict rule to serve as a reviewer of con-
flicts generated by rules. These are created and maintained in LogicalApps AppsFlow; 
for instructions on configuring them, refer to the AppsFlow User’s Guide. 

Creating Conflict Rules Manually 
In broad terms, creating a conflict rule involves specifying two conflicting “entities,” 
either responsibilities or functions; noting the applications to which those entities 
belong; and selecting a control type, a reviewer, and a few other parameters. You can 
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complete all these tasks in the copy of the Conflict Matrix that opens when you se-
lect the AppsAccess — Define Conflict Rules option in the LogicalApps Navigator:  

 
To create a conflict rule in the Conflict Matrix: 

1 Activate a row in the grid on the Conflict Matrix. Use any of these methods: 

• If the Conflict Matrix grid contains any empty rows, click in the first one. 

• Click on the New button, which is first on the left in the tool bar. 

• Click on File in the menu bar, then on New in the File menu. 

• Open the Find Conflict Rules form and click on its New button. 

2 Type a name for the rule in the Conflict Rule Name field.  

3 In the Entity Type list of values (LOV), select Responsibility or Function.  

4 Select the “base” entity — the first of two functions or responsibilities your rule 
is to define as conflicting.  

You may select the entity directly in the Entity LOV, which lists all responsibili-
ties or all functions, depending on your selection in the Entity Type LOV. If you 
do, AppsAccess displays your selection in the Entity LOV and the application to 
which it belongs in the Application LOV. 

Or you may first select an application in the Application LOV. AppsAccess then 
filters the values available in the Entity LOV to those responsibilities or functions 
belonging to the application you chose; select one of them.  

If you chose Function in the Entity Type LOV, one of the values available in the 
Application LOV is No Associated Application; it enables you to select, in the Entity 
LOV, a function that does not belong to any application. 

5 Select the conflicting entity — the second of the two entities your rule is to define 
as conflicting. Use either of the methods you could use to select a base entity, but 
this time in the Conflicting Application and Conflicting Entity lists of values. 



 Chapter 2: Defining Conflict Rules  

User’s Guide: AppsAccess 6.5.8 9 

6 In the Control Type list box, select the control type you want to apply to the rule 
— Prevent, Allow with Rules, Allow with Rules (with Approval), or Approval Re-
quired. (See page 1 for definitions of these control types.) 

7 In the Reviewer LOV, select the person (workflow role) who is to review individ-
ual conflicts generated by the rule. Although the review of conflicts applies only to 
a rule of the Allow with Rules (with Approval) or Approval Required control type, 
you must select a reviewer for every rule you create — even those of the Allow 
with Rules or Prevent type. 

8 In the Approval Group LOV, you may select an approval group with authority 
to review individual conflicts generated by the rule. If you enter a value in this 
optional field, AppsAccess ignores the value entered in the mandatory Reviewer 
field. If you omit a value here, AppsAccess uses the value in the Reviewer field. 

9 Select the Same OU check box if you want the rule to apply only within individ-
ual operating units. Select the Same SOB check box if you want the rule to apply 
only within individual sets of books. Clear the appropriate check box if you want 
the rule to apply across operating units or sets of books. 

10 In the Reason box, type an explanation of the business risk addressed by this 
conflict rule. (This reason appears in the LA AppsAccess Conflict Matrix Report.) 

11 In the Start Date field, select a date on which the rule takes effect. In the End Date 
field, select a date on which the rule expires. (Assigning the current date, or an 
earlier one, as an end date inactivates the rule; you can edit the rule to delete the 
end date later, when you are ready to use the rule.) 

By default, Start Date is set to the date on which you create the rule and End Date 
is blank, so that the rule takes effect immediately and remains in effect indefinitely. 
To change these values, select a date in the pop-up calendar that appears when you 
click on either list-of-values icon. Or type a date in the format configured for 
your instance of Oracle Applications. 

If you selected the Prevent or Approval Required control type (in step 6), you need 
only save the rule. If you selected either of the Allow with Rules types, you must link 
this rule with one or more AppsForm rules. To do so, complete these steps: 

1 In the Conflict Matrix, click on the AppsForm Rules button (which becomes 
active only when you select an Allow with Rules control type.) An AppsForm 
Rules form appears: 
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2 From the AppsForm Rule list of values, select a rule that addresses the conflict. 

3 In the Comment box, explain why the AppsForm rule is being attached to this 
conflict rule. 

4 Allow AppsAccess to complete the Creation Date and Active fields. 

The Creation Date field defaults to the date and time you establish a link between 
the AppsForm and AppsAccess rules — the system date at the moment you select 
the AppsForm rule. (It appears after you refresh the AppsForm Rules form.) 

The Active check box is selected by default if the AppsForm rule is active. You can 
choose only among active rules, so the check box is always selected initially. If you 
inactivate a rule in AppsForm, however, the check box is cleared here automatically. 

5 You may want the conflict rule to invoke more than one AppsForm rule. If so, 
repeat steps 2–4 for each AppsForm rule you want to invoke. 

6 Close the AppsForm Rule form: click on the × symbol in its upper right corner. 

Once you’ve completed all configuration steps, save the conflict rule: Click on File in 
the menu bar, then on Save in the File menu. Or click on the Save icon, located fourth 
from the left in the toolbar. 

Creating Global Subscribers 
You can specify submenus, functions, data groups, operating units, and users who 
are exempt from conflict rules. Items designated for exclusion (or, in one case, in-
clusion) are called global subscribers. 

Global subscribers can ensure that query-only access to Oracle Applications features 
does not trigger rules, even when standard access would. Or, global subscribers can 
make the cleanup process more manageable. The number of conflicts found by 
AppsAccess is typically large, so you can create global subscribers to generate fewer 
conflicts. See “Managing Cleanup” on page 27.  

To create global subscribers, click on the Global Subscribers button in the Define 
Conflict Rules copy of the Conflict Matrix. (The button is disabled in the User Conflict 
Approval copy.) A Global Subscribers form opens; in it, click on the tab for a sub-
scriber type. 

Operating Units  
You can select operating units either to be included in, or excluded from, conflict-
rule processing. These selections apply to operating units assigned to users, responsi-
bilities, applications, or sites through use of the “MO: Operating Unit” profile option 
in the system administrator responsibility. The option may be set simultaneously at 
any or all of these levels, and the active setting is the one at the most narrowly 
focused level (first user, then responsibility, then application, then site). 

1 In the Global Subscribers form, click on the Include/Exclude Operating Units tab 
(as shown in the figure at the top of the next page). 
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2 Select operating units in the list-of-values fields under either of the Include and 

Exclude headings. It is permissible to have entries in both lists simultaneously.  

3 Select or clear the Active check boxes next to the entries: 

• If Active check boxes are selected under the Include heading, the correspond-
ing operating units are eligible for conflict-rule processing and all others are 
excluded.  

• If Active check boxes are selected under the Exclude heading, the correspond-
ing operating units are excluded from conflict-rule processing, and all others 
are included. 

Do not select Active check boxes simultaneously under both the Include and Ex-
clude headings. Otherwise you will be unable to save the subscriber configuration. 

Submenus 
A submenu under one menu may provide query-only access to functions, even 
though the same submenu under another menu provides write access to the same 
functions. A conflict rule that includes such a function would trigger conflicts for all 
instances of the function — rightly when a user has write access, but falsely for 
query-only access. 

To exclude just the query-only functions from conflict-rule processing, create sub-
menu subscribers: 

1 In the Global Subscribers form, click on the Exclude Sub-Menus/Functions tab: 
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2 Make selections in the Menu Name, Sub-Menu Name, and (optionally) Function 
Name list boxes. (The last of these and other fields come into view as you scroll 
the form to the right.) AppsAccess supplies corresponding values in the User 
Menu Name, User Sub Menu Name, and User Function Name fields. This exclu-
sion feature recognizes only direct parent-child relationships: 

• To exclude a submenu, specify that submenu and its immediate parent menu; 
use the Sub-Menu Name and Menu Name fields (respectively). To exclude a 
submenu is to exclude all functions available from that submenu.  

• To exclude a single function, specify that function and its immediate parent 
submenu; use the Function Name and Menu Name fields (respectively). Note 
that you would include the submenu name in the Menu Name field and would 
leave the Sub-Menu Name field blank. 

3 Select the Active check box to place the global subscriber in use, or clear the 
check box to remove it from use.  

Data Groups 
To eliminate false conflicts that can occur when custom responsibilities are assigned 
to query-only data groups, you can exempt data groups from conflict-rule processing: 

1 In the Global Subscribers form, click on the Exclude Data Groups tab: 

 
2 In the Data Group lists of values, select the group that is to receive the exclusion. 

If a description was written when the group was created, it appears by default in 
the Description box. If no description was written, the box remains blank. The 
Description box does not accept direct input. 

3 The Active check box is selected by default. Leave it selected for the exclusion to 
take effect. Clear it (click on it so that no check mark appears) to reserve an exclu-
sion for the group, but not have it take effect at present. 

Users 
You can exclude individual users from conflict-rule processing: 

1 In the Global Subscribers form, click on the Exclude Users tab (as shown in the 
illustration at the top of the next page). 
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2 In the User Name list of values, select the ID of the user who is to receive the 

exclusion. 

If a description of the user was written when the user ID was created, it appears 
by default in the Description box. If no description was written when the user 
ID was created, the box remains blank. The Description box does not accept 
direct input. 

3 The Active check box is selected by default. Leave it selected for the user exclu-
sion to take effect. Clear it (click on it so that no check mark appears) if you want 
to reserve a user exclusion for the user, but not have it take effect at present. 

Finishing the Subscriber Configuration 
When you finish working in the Global Subscriber forms, save the subscribers 
you’ve created: Click on File in the Oracle Applications menu bar, then on Save in 
the File menu. (Once you’ve created and saved a subscriber, you cannot delete it, 
although you can deactivate it by clearing its Active check box.) Then close the 
Global Subscriber forms: Click on the × symbol in the upper right corner.  

You can print a report that lists all global subscribers; see page 38. 

Uploading Conflict Rules from a Spreadsheet 
Rather than create rules one at a time in the Conflict Matrix, you can select rules in a 
Microsoft Excel spreadsheet, edit them in the spreadsheet to contain values appropri-
ate for your site, and then upload them all at once. Before you start, be sure you know 
the name of the ODBC driver that enables you to connect to your Oracle system. 

To prepare the spreadsheet for uploading: 

1 Open the AppsAccess LA_SOD spreadsheet. 

2 In the upper left corner of the Access Load Values sheet, provide the ODBC 
driver name, connect string, Apps user name, and Apps password. 

3 Click on the Update Data button. The spreadsheet is populated with up to 
65,536 rows of rule data. (Owing to Excel limitations, this is the maximum 
number possible.) 
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4 Review the rules and select those you want to upload: In the Load column, select 

the value Y for rules you want and N for rules you don’t want. 

5 Edit the Control Type, Reviewer, and Reason values as appropriate for the rules 
you are uploading. You cannot change the values in other columns. 

In particular, SYSADMIN is the default conflict reviewer for all rules in the spread-
sheet. For each rule, change this value to an appropriate person (role). 

6 On the Tools menu, click Create CSV for AppsAccess. In response to prompts, 
enter a file name and location. Click OK to save the file. 

Note 
The Create CSV for AppsAccess option appears in the Excel Tools menu 
only if the macro security level for Excel is set to low. To effect this setting, 
click on Tools in the Excel menu bar, then on Options in the Tools menu. 
In the Options window, click on the Security tab. In the Security panel, click 
on the Macro Security button. A Security window opens; in its Security 
Level panel, click on the Low radio button. Then close the Security and 
Options windows — click on the OK button in each. 

To upload the file you’ve prepared: 

1 As an admin user, upload the CSV file to your UTL directory on the database 
server.  

2 Open the Navigator in the LogicalApps responsibility. Click on View in the 
menu bar, then on Requests in the View menu. 

3 A Find Requests form opens. Click on its Submit a New Request button. In the 
Submit a New Request dialog, click on Single Request and then on the OK 
button. 

4 A Submit Request form opens. In its Name list of values box, select LA 
AppsAccess Load Conflict Rules. 
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5 A Parameters form appears. In it, supply the following values: 

• Load: From the list, select Yes to load the data. (The value No would validate 
the data without loading it.) 

• Flat Filename: Enter the name you created for the CSV file. 

• Flat File Path: Enter the location you established for the file. 

• Log Details: From the list, select Yes to created a detailed log or No to create 
a more cursory log. Typically, you would select Yes only to troubleshoot a 
problem with an upload operation. 

6 In the Submit Request form, click on the Submit button. At the next prompt, 
make a note of the request number, then click on No to return to the Find 
Requests form. 

7 To view the log, click on the Specific Requests button. Type the ID number for 
your request in the Request ID field, and click on the Find button. 

8 A Requests form shows the status of your request. When it informs you that the 
request is completed (you may have to click on the Refresh Data button), click 
on the View Output button. A log file similar to the following one appears: 
+-----------------------------------------------------------------------+ 

LogicalApps Custom: Version : UNKNOWN – Development 

Copyright © 1979, 1999, Oracle Corporation. All rights reserved. 

LAA_LOAD_CONFLICT module: LA AppsAccess Load Conflict Rules 

+-----------------------------------------------------------------------+ 

Current system time is 25-JAN-2006 11:27:52 

+-----------------------------------------------------------------------+ 

**Starts**25-JAN-2006 11:27:52 

**Ends**25-JAN-2006 11:33:28 

+-----------------------------------------------------------------------+ 

Start of log messages from FND_FILE 

+-----------------------------------------------------------------------+ 

After Inserting Into Interim Table 

-------------------------------------------------------------- 

Total of 333 Records Inserted Into Interim Table 
Out of 333 Records 1 Records Have Error 

-------------------------------------------------------------- 

Enter Bank Transaction Codes*Enter Bank Transaction | Invalid Conflict 
Function/Responsibility Name 

-------------------------------------------------------------- 

+-----------------------------------------------------------------------+ 

End of log messages from FND_FILE 

+-----------------------------------------------------------------------+ 
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Chapter 3 

Generating and Reviewing Conflicts  

Once conflict rules are defined and saved, the next step is to generate conflicts — to 
have AppsAccess search through users’ work assignments for violations of the rules. 
For each rule, you can then open a User Conflicts form to view a list of the conflicts 
the rule has generated, together with the user affected by each conflict and its status. 

For conflicts generated by Prevent or Allow with Rules conflict rules, the status is set 
to Prevent or Allow with Rules, respectively, and stays that way. For Allow with Rules  
(with Approval) or Approval Required conflicts, the reviewer designated in the con-
flict rule sets the status of conflicts — approves or rejects them — individually in a 
User Conflict Actions form or many-at-once in a Mass Update User Conflicts form. 

However, the assignment of status in either of the User Conflict Actions or Mass 
Update User Conflicts forms does nothing more than add information to reports. It 
neither grants, denies, nor prevents access to conflicting responsibilities or functions. 
The actual implementation of conflict rules is carried out through a combination of 
manual and automated processes, which are discussed in detail in Chapter 4. 

Generating User Conflicts 
When you generate user conflicts, AppsAccess evaluates all active conflict rules 
(those whose end dates have not passed) and produces a “snapshot” — a set of con-
flicts existing at the current moment, as distinct from other sets of conflicts generated 
at past moments. With each new snapshot, AppsAccess saves the previous snapshot 
to an archive table. 



Chapter 3: Generating and Reviewing Conflicts  

18 User’s Guide: AppsAccess 6.5.8 

Thus rules may be added or edited, but the existing snapshot reflects the way rules 
were configured the last time conflicts were generated, and will continue to do so 
until the Generate User Conflicts process is run again. So you should generate user 
conflicts whenever conflict rules change. 

Before generating conflicts, you may choose to run an Analyze Responsibility Conflicts 
concurrent request. It can speed up conflict generation if rules have changed. See “Man-
aging Cleanup” on page 27 and “Analyze Responsibility Conflicts” on page 39. 

For the first of two methods to generate user conflicts, complete these steps: 

1 Open the Define Conflict Rules copy of the Conflict Matrix. (See page 3.) It is 
unimportant whether the Conflict Matrix displays any conflict rules. 

2 Click on the Generate User Conflicts button (located at the lower left of the 
Conflict Matrix form).  

3 A message informs you that a generate-user-conflicts request has been submitted. 
Make a note of the request ID, and click on the OK button to clear the message. 

 
The Generate User Conflicts button is active in the Define Conflict Rules copy of 
the Conflict Matrix, but not in the User Conflict Approval copy. However, you can 
generate conflicts no matter which Conflict Matrix form is open (or even when only 
the LogicalApps Navigator is open). To do so, use the Requests option on the View 
menu to launch the LA AppsAccess Generate User Conflicts concurrent request. (See 
“Reports and Concurrent Requests” on page 31.) 

Reviewing User Conflicts 
To view the conflicts you’ve generated, refresh the Conflict Matrix — reload the rules 
in which you are interested, even if they were already loaded in the Conflict Matrix 
when you initiated the generate-user-conflicts request. To review user conflicts: 

1 Click in the Find Conflict Rules form to make it active. Use it to locate the rules 
you want and load them into either copy of the Conflict Matrix. (See pages 4–5.) 
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2 When users’ work assignments violate a rule, AppsAccess places a check mark in 
a Conflicts Exist box for that rule. The check box is located to the right of the 
Conflict Matrix row in which the rule is defined:  

 
3 Select one of the check-marked rules. (Click on the row in which it is defined; 

note that a rectangle to its left turns blue.) Then click on the User Conflicts but-
ton. The following User Conflicts form presents a list of all users who possess 
both of the responsibilities or functions that the rule defines as being in conflict. 
(To arrange results in alphabetical order by user name, select the Order Conflicts 
by Username check box.) 

 
4 Note each user’s status, which depends on the control type defined for the rule:  

• If the control type is Approval Required or Allow with Rules (with Approval), 
each user’s status begins at Pending. This status can be updated (see below). 

• If the control type is Allow with Rules, each user’s status is Allow with Rules. 
This status cannot be updated. 

• If the control type is Prevent, each user’s status is Prevent. This status cannot 
be updated. 
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Updating Status for User Conflicts 
You can open a User Conflict Actions form and, in it, update the status of a conflict 
if the following conditions are true: 

• You opened the User Conflicts form from the User Conflict Approval copy of 
the Conflict Matrix.  

• The conflict was generated by a rule whose control type is Approval Required or 
Allow with Rules (with Approval). The status of such a conflict is Pending, Ap-
proved, or Rejected; you can update any of these statuses from one to another. 

• You are the reviewer designated in the rule that generated the conflict. (If not, 
you can open the User Conflict Actions form to view, but not update, approval 
status). 

• No on-line approval request is pending for the conflict. (Such a request would be 
launched by an “approval flow” at the moment that the assignment of responsibili-
ties to a user violated the conflict rule. If such a request is pending, conflict status 
can be updated here only indirectly, through a response to the notification; see 
Chapter 4.) 

To update status for a conflict: 

1 In the User Conflicts form, select a conflict to update. (That is, click on the row 
in which it is defined. The row is selected when a rectangle to its left turns blue.) 

2 Click on the Action/Action History button, and the User Conflict Actions form 
opens. (If an on-line approval request is pending, a pop-up message alerts you to its 
existence and states that no action can be taken.) 

 
3 If status has not yet been assigned to the conflict, the form displays a single row 

in which you can work. Otherwise, the form displays one row for each time a 
user has assigned status to the conflict; in this case, click in the first empty row to 
activate it, and work in that row. (This assumes that no on-line approval request 
is pending; if one is, the form displays no information and cannot be updated.) 

4 In the Action Type field, select Approved, Rejected, or Pending. 

Approving a user conflict means that you know it exists and decide to allow it for 
the user. Rejecting a user conflict means that you decline to allow the user access 
to conflicting responsibilities or functions. Pending is the default status assigned 
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by AppsAccess, indicating that a decision is yet to be made. Approvals and rejec-
tions made in this form are logged to AppsAccess reports, but do not take effect. 

5 Specify dates during which this status is to remain in effect. 
Start Date defaults to the date on which you are taking action. Accept the default 
or modify it to specify a future date on which you want the action to take effect.  
End Date is blank by default. Insert a date on which you want the status to expire, 
or leave the box blank to allow the status to remain in effect indefinitely. An end 
date earlier than the start date prompts AppsAccess to present an error message. 
In either case, select a date in the pop-up calendar that appears when you click on 
the list-of-values icon. Or type a date in the format configured for your instance 
of Oracle Applications. 

6 In the Comments box, type a comment explaining why this conflict should be 
approved, rejected or left pending.  

7 Click on the Done button. A dialog box prompts you to save your work; click 
Yes to preserve the action you selected or No to discard it. The User Conflict 
Actions form closes and the focus returns to the User Conflicts form; click on its 
Refresh button to see the status you’ve selected. 

Mass Updating User Conflicts 
You can define sets of conflicts and review them all at once, rather than one at a 
time. You can approve or reject the conflicts in any combination, and give a reason 
for your decision. Decisions made in this form are logged to reports, but do not take 
effect. If an on-line approval request is pending for a conflict, its status here can be 
updated only indirectly, through a response to the notification; see Chapter 4. 

1 In the User Conflict Approval copy of the Conflict Matrix form, click on the 
Mass Update button. The following Mass Update User Conflicts form appears: 
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2 The Mass Update form can display only conflicts generated by rules for which 
you are a designated approver. To see all such conflicts, enter no filtering values 
in the six fields at the top of the form (and skip to step 3). Or, to specify conflicts 
you want to update, select any combination of the following filtering values: 
• Username: Select a user ID to produce a list of conflicts affecting that user. 
• Conflict Rule Name: Select a rule name to produce a list of conflicts gen-

erated by a particular rule.  
• Application: Select an application name to produce a list of conflicts gener-

ated by rules for which this is the base application. 
• Conflicting Application: Select an application name to produce a list of 

conflicts generated by rules for which this is the conflicting application. 
• Responsibility: Select a responsibility name to produce a list of conflicts 

generated by rules for which this is the base responsibility. 
• Conflicting Responsibility: Select a responsibility name to produce a list of 

conflicts generated by rules for which this is the conflicting responsibility. 
If you attempt to search for conflicts that have been approved or rejected, the 
search produces no results. 

3 Click the Find button. (To arrange results in alphabetical order by user name, 
select the Order Conflicts by Username check box first.) The grid displays Pend-
ing conflicts that conform to your search parameters.  
Each row in the grid displays information about a conflict: the name of the affected 
user and the names of the conflict itself, its base responsibility, and its conflicting 
responsibility. Another row near the bottom of the form displays more informa-
tion about the conflict currently selected in the grid: the names of its base appli-
cation, conflicting application, base function, and conflicting function. (For a 
responsibility conflict, the function fields actually repeat the names of the base 
and conflicting responsibilities, since functions don’t apply for such a rule.) 

4 Review the conflicts and use any of these methods to approve or reject them: 
• Click in the Approve or Reject check box to the right of each conflict entry. 
• Click on the Select All Approval button to approve all the conflicts. 
• Click on the Select All Reject button to reject all the conflicts. 
• If you change your mind, click the De-Select All Approval or De-Select All Reject 

button to rescind either the approvals or the rejections you have made. 
5 Click the Action button and, in a Mass Update Action dialog, type a reason for 

your updates. Then click the OK button. 
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6 A message informs you that the updates have been saved. Click its OK button.  

When you finish updating status for a set of conflicts, you can load another set and 
update their status. You can click the Clear button to remove entries currently dis-
played in the grid, but this is not necessary; if you specify new search parameters and 
click the Find button, the newly specified conflicts replace the old set in the grid.   

To close the Mass Update User Conflicts form, click on its Done button. 
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Chapter 4 

Resolving Conflicts  

Although a conflict is defined, and may be approved or rejected, in AppsAccess, it is 
not resolved until actions are taken outside of AppsAccess. These actions may include: 

• Adjusting the end dates for responsibilities assigned to a user affected by a con-
flict. For an approved conflict, end dates may be set in the future (or removed) 
so that access to a responsibility is extended. For a rejected conflict, end dates are 
set to the present moment so that access to a responsibility is cut off.  

• Excluding one or more conflicting functions from a responsibility or from 
menus, or removing a submenu containing conflicting functions from menus. 

• Adding a user affected by an Allow-with-Rules conflict as a subscriber to the 
AppsForm rule associated with the conflict rule. For instructions on adding sub-
scribers to AppsForm rules, see the AppsForm User’s Guide.  

The process for effecting these resolutions depends on whether a user has been as-
signed duties before or after an AppsAccess rule is created to define them as conflicting. 

Manual Conflict Resolution 
The first time conflicts are generated, and afterwards whenever conflict-rule defini-
tions change, you are likely to uncover users who have been granted access to respon-
sibilities or functions before conflict rules defined them as conflicting. AppsAccess 
uncovers these conflicts, but does not resolve them. Instead, you must eliminate 
these conflicts manually, a process known as “cleanup.” 
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Cleanup Procedures 
To uncover these conflicts, you would generate user conflicts and then review them, 
either in the User Conflicts form or in the User Conflicts report. The course of action 
for each conflict depends on its control type: 

• For an Allow with Rules conflict, the user’s access to conflicting entities should 
be permitted to continue.  

• For a Prevent conflict, the user’s access to one or both conflicting entities would 
have to be terminated.  

• For an Allow with Rules (with Approval) or Approval Required conflict, the 
user’s access could be approved or rejected. For auditing purposes, the reviewer 
should also assign status to the conflict in the User Conflict Actions form or the 
Mass Update User Conflicts form. 

To allow or approve a conflict, you need do nothing in Oracle Applications. 

To prevent or reject a conflict, you have four options. The first resolves a function- or 
responsibility-based conflict. The remaining three are appropriate for function-based 
conflicts — particularly those involving two functions within a single responsibility: 

• In the Oracle Applications Users form, set the end date for at least one responsi-
bility involved in the conflict to the current date. 

• Exclude one of two conflicting functions from the responsibility through which 
the user has access to that function. 

• Remove the function from menus through which the user has access to it, or 
remove a submenu containing a conflicting function from the user’s menus. 

• Exclude those menus from the responsibility that provides the user with access 
to the function. 

See Oracle documentation for procedures on excluding functions or menus from 
responsibilities, or removing functions from menus. To facilitate mapping functions 
to menus, an AppsAccess feature defines paths to menus on which functions reside:  

1 In the User Conflicts form, select the row for a function conflict you want to 
resolve.  

2 Click on Tools in the menu bar, and either Where Used or Conflict Where Used 
in the Tools menu: 

• If you selected Where Used, a Menu Path window shows the menus in which 
the “base entity,” as defined in the AppsAccess conflict rule, resides. 

• If you selected Conflict Where Used, the Menu Path window shows the 
menus in which the “conflicting entity” resides. In this example, that entity is 
the Receipts function: 
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Managing Cleanup 
The number of conflicts found by AppsAccess is typically quite large, numbering in 
the millions at some sites. This can affect the performance of the Generate User Con-
flicts process, but perhaps more importantly may result in a complex cleanup proc-
ess. You can, however, take steps to manage the process effectively: 

• As noted earlier, you may choose to identify a set of rules that are of the most 
immediate importance, generate conflicts only for them, and clean up those con-
flicts before implementing another set of rules. You may create only as many 
rules as you intend to run at a given moment, or you may create (or upload) all 
the rules you anticipate needing, but inactivate those you are not ready to run at a 
given moment. To inactivate a rule, load it in the Conflict Matrix and insert the 
current date in the End Date field. When you are ready to use the rule, reactivate 
it by editing it again to delete its end date. 

• When you change conflict-rule definitions, run the Analyze Responsibility Con-
flicts concurrent request before generating a new conflict snapshot. It speeds the 
process of generating conflicts by reducing function conflicts to the responsibility 
level (and so permitting them to be matched to users who are assigned responsi-
bilities). 

• Some users may account for disproportionately large numbers of conflicts. You 
can exempt them temporarily from conflict-rule processing by configuring them 
as global subscribers (see page 12), and then generate and clean up conflicts asso-
ciated with other, “ordinary” users. Once that’s done, you can deactivate the global 
subscriber status for the “high intensity” users (all or some of them) and clean up 
their conflicts, continuing until all users are accounted for. You may anticipate in 
advance that some users (for example, those with superuser responsibilities) will 
be high-intensity. Or you may discover others when you generate conflicts, and 
at that point exempt them and generate a new conflict snapshot. 

• You may identify a number of operating units (say, three) that are in most imme-
diate need of cleanup, execute conflict rules only for them, clean up the resulting 
conflicts, and then move on to other operating units. You can focus on one or a 
set of operating units by, once again, creating global subscribers (see page 10), 
either selecting operating units to be included in rule analysis, or excluding all 
other operating units from rule processing. 

Automated Conflict Resolution 
Whenever a new user is created or an existing user is assigned new responsibilities, 
AppsAccess evaluates the assignment for violations of existing conflict rules, and 
then presents an option to “submit” or cancel it. If the assignment is submitted, 
AppsAccess denies access for a Prevent conflict, grants access for an Allow with 
Rules conflict, or sends on-line notifications to reviewers for an Allow with Rules 
(with Approval) or Approval Required conflict. A reviewer approves or rejects the 
last of these simply by responding to the notification. 
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Activating Responsibilities 
The process begins in the Oracle Applications Users form, as a new user is created 
or an existing user receives new responsibility or function assignments. (See Oracle 
documentation for information on accessing the Users form and configuring users.) 

1 With the Users form open, a system administrator selects a user and, in the grid 
accessible from the Responsibilities tab, assigns responsibilities. Both the start 
and end dates for these responsibilities are set by default to the current date, and 
cannot be modified directly. The administrator saves the new assignments.  

2 The administrator clicks on Actions in the menu bar, then on Assign Responsi-
bilities in the Actions menu. An Activate Responsibilities form opens; it presents 
a copy of the responsibilities listed in the Users form, but allows the administra-
tor to change the end dates. 

 
Note 
If the Assign Responsibilities option is inactive, use a Mass Associate feature, 
available in AppsForm or AppsFlow, to associate a function called AppsAccess 
Activate Responsibilities with either the responsibility or the menu from 
which you gain access to the Users form. For information on using the Mass 
Associate feature, see the user’s guide for AppsForm or AppsFlow. 

3 The administrator removes end dates (or alters them to a future date) for a selec-
tion of responsibilities, and so provisionally grants access to them. He then clicks 
the Initiate Conflict Analysis button. 
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4 An Initiate Conflict Analysis form provides data about responsibilities for which 
the administrator changed end dates, noting those for which no conflict exists and 
listing all conflicts in which the responsibilities are involved. For each conflict, a 
Status field displays a message: 
• For a Prevent conflict, end dates will not be removed. 
• For an Allow with Rules conflict, end dates will be removed, provided that 

the conflict rule is associated with an AppsForm rule. 
• For an Allow with Rules (with Approval) or Approval Required conflict, an 

approval flow will be launched. 

 
5 The administrator may, at this point, take either of two actions: 

• Click on the Cancel button to avoid assigning conflicting responsibilities. The 
Activate Responsibilities form would reappear; the administrator would click 
on its Cancel button, and then on the No button in a prompt to save changes. 
He can then reselect the Assign Responsibilities option in the Actions menu 
and try granting access to a different selection of responsibilities. 

• Click on the Submit button to accept the selection of responsibilities, even if 
it contains conflicts. AppsAccess then grants access to responsibilities with no 
conflicts. For responsibilities with Allow with Rules conflicts, it grants access 
if the conflict rule is associated with an AppsForm rule, but denies access if 
not. For responsibilities with Prevent conflicts, it denies access.  
In these cases, “granting access” means setting end dates in the Users form 
to match those selected in the Activate Responsibilities form — or removing 
them if they have been removed in Activate Responsibilities. “Denying access” 
means setting end dates in the Users form to the current date. 
For responsibilities involved in Allow with Rules (with Approval) or Approval 
Required conflicts, AppsAccess sends notifications to approvers. The end 
dates in the Users form remain temporarily set at the current date. Whether 
that value is made permanent or reset depends upon the approvers’ responses 
to the notifications. 
However, AppsAccess takes the most restrictive possible action when respon-
sibilities are involved in multiple conflicts. For example, when a responsibility 
assignment violates both a Prevent and an Approval Required rule, access is 
denied and no notification is sent to approvers. The “pecking order” is Pre-
vent, Allow with Rules (with Approval), Approval Required, Allow with Rules, 
no conflict.  
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Responding to Notifications 
For an Allow with Rules (with Approval) or Approval Required conflict, members of 
the workflow role specified in the conflict rule as the reviewer receive an on-line noti-
fication. The first member to respond set the status of the conflict (and, once she has 
done so, the notification is removed from the inboxes of other role members). To re-
spond to a notification: 

1 In your Oracle workflow worklist, locate the approval notification and click on it 
to open it: 

 
2 Review information about the assignment of responsibilities that either conflict 

with one another or contain conflicting functions. For an Allow with Rules (with 
Approval) conflict rule, the message identifies the AppsForm rule intended to miti-
gate the conflict. Optionally, type a comment explaining your approval decision. 

3 Click one of the following buttons: 

• Approve: The user is given access to the responsibilities. When they were 
provisionally assigned, their end dates were removed or set to a future date in 
the Activate Responsibilities form. Approval of this notification resets the end 
dates in the Users form to match the setting in the Activate Responsibilities 
form. (This takes effect, however, only when the Oracle Workflow back-
ground process has run.) 

• Reject: The user is denied access to the responsibilities. End dates in the Users 
form are set permanently to the dates that were current when the responsibil-
ities where provisionally assigned. 

• Reassign: You reassign the conflict to another reviewer. The originally assigned 
end dates remain, but an approval by the other reviewer will remove them.  

4 Click on the Return to Portal link. 

The decision you make automatically updates the AppsAccess User Conflicts form. 
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Chapter 5 

Reports and Concurrent Requests  

AppsAccess provides a set of reports that presents not only the results of analysis for 
use in locating and resolving conflicts, but also, for auditing purposes, data about rule 
configuration and user exclusions. Reports are available in text and PDF formats. 
AppsAccess also accepts “concurrent requests” — it runs utility programs that archive 
data, prepare export files or load import files, reset values, and generate user conflicts.  

Running Reports or Requests 
To run any of the reports or concurrent request programs: 

1 With the LogicalApps Navigator open, click on View in the Oracle Applications 
menu bar, then on Requests in the View menu. The Find Requests form appears: 
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2 Click the Submit a New Request button. At the prompt, select Single Request 
and click OK. The Submit Request form appears:  

 
3 In the Name list of values, select the name of the report or request you want to 

run. Click on the OK button. 

4 If a report or request takes parameters, a Parameters form appears. To filter entries 
in a report or items subject to a request, select values for any number of parameters. 
Or, to include all possible entries or items, leave the parameters blank. Parameters 
vary from one report or request to another. (See the description of each report or 
request for a discussion of its parameters.) Click on the OK button. 

5 In the Submit Request form, click on the Submit button. At the next prompt, 
make a note of the request number; then click on Yes to run another report or 
request, or no to return to the Find Requests form. 

6 To see the results of a report, or check on the progress of a report or request, 
click on the My Requests in Progress radio button and then on the Find button. 
Or click on the Specific Requests radio button, type your request number in the 
Request ID field, and click on the Find button. 

7 A Requests form shows the status of your request. Click the View Output button 
to see results. (From this form, you can also click the Submit a New Request but-
ton to begin the process of generating another report or request.)  
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Conflicts Summary Report 
The Conflicts Summary Report shows the number of conflicts per application — the 
total and the number at each of the approved, rejected, pending, and prevent statuses. 
For each application, the report groups conflicts by responsibility. However, there 
are two ways in which a responsibility may be considered to be associated with an 
application: the first is a direct association, with a given responsibility linked to only 
one application. The second way is through the following linkage: an application is 
associated with a function, which is associated with a menu, which is granted to a 
responsibility. To ensure a correct count of both function- and responsibility-based 
conflicts for each application, the report bases its calculations on the second associa-
tion. As a result, the report may show responsibilities within an application that are 
not directly linked to the application. 

Moreover, a given conflict is counted in each of the applications (base and conflict-
ing) it affects. A rule, for example, may define a conflict between two functions, each 
associated with a distinct application. If the rule were to generate 10 conflicts, the re-
port would show 10 conflicts in each of the applications, for a total of 20. 

As you generate the report, you can select these parameters: 

• Run Date: Select a date to view summary values for conflicts generated up to 
that date. This parameter is required. 

• Application: Select an application to view summary values for conflicts associ-
ated with that application. Or, leave the parameter blank to view summary values 
for conflicts associated with all applications.  

The Conflicts Summary Report looks like this: 
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Responsibilities with Conflicts Report 
The Responsibilities with Conflicts Report lists responsibilities for which conflicts 
exist, and identifies the components of each conflict as well as the rule that defines it. 
As you generate the report, you can select the following parameters: 

• Application Name: Select an application to view responsibilities that have conflicts 
associated with the application. Or leave the parameter blank to view responsibili-
ties that have conflicts associated with all applications. 

• Responsibility: Select a responsibility to view only conflicts for that responsi-
bility. Or leave the parameter blank to view conflicts for all responsibilities.  

• Function: Select a function to view only conflicts involving that function. Or 
leave the parameter blank to view conflicts involving all functions. You can select 
a function only if you have first selected an application. 

• Control Type: Select a control type — Approval Required, Allow with Rules (with 
Approval), Allow with Rules, or Prevent — to view only conflicts of that type. Or 
accept the default value, All, to view conflicts of all types.  

• Conflict Within Same Responsibility: Select Y (for yes) to view information on 
conflicts between functions within a responsibility, or N (for no) to view informa-
tion on conflicts between entities across responsibilities. Or leave this parameter 
blank to view information on conflicts of both types. 

The Responsibilities with Conflicts Report looks like this: 

 



 Chapter 5: Reports and Concurrent Requests  

User’s Guide: AppsAccess 6.5.8 35 

User Conflicts Report 
The User Conflicts Report presents information on the resolution of conflicts for 
individual users. For each conflict, it presents the most recent approval decision 
made as of the date on which the report is run. It collects data generated when 
conflicts are resolved in the User Conflict Actions form. A system administrator 
would use information from the report to implement conflict-resolution decisions. 
As you generate the report, you can select the following parameters: 

• Snapshot Run Date: Select a date to view summary values for conflicts generated 
up to that date. This parameter is required. 

• Conflict Rule Name: Select a rule to view information on the resolution of 
conflicts generated by that rule. Or leave the parameter blank to see information 
on the resolution of conflicts generated by all rules. 

• Control Type: Select a control type — Approval Required, Allow with Rules (with 
Approval), Allow with Rules, or Prevent — to view only information on the 
resolution of conflicts generated by that type of rule. Or accept the default value, 
All, to see information on the resolution of conflicts generated by all types of 
rule. 

• User Name: Select a user ID to view only information on the resolution of con-
flicts concerning that user. Or leave the parameter blank to see information on 
the resolution of conflicts concerning all users. 

The User Conflicts Report looks like this: 
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Conflict Matrix Report 
The Conflict Matrix Report lists conflict rules and, for each rule, displays the values 
that define it. As you generate the report, you can select the following parameters: 

• Conflict Rule Name: Select a conflict rule to view information only about that 
rule. Or leave this parameter blank to see information about all rules. 

• Entity Type: Select Function or Responsibility to view rules that find conflicts in 
one entity or the other, or Both to see both types of rule. 

• Application Name: Select an application to view rules that involve that applica-
tion, or leave the parameter blank to view rules that involve any application. 

• Control Type: Select a control type — Approval Required, Allow with Rules (with 
Approval), Allow with Rules, or Prevent — to view only information on conflict 
rules involving that type. Or accept the default, All, to see information on 
conflict rules involving all types. 

• Conflicts Exist: Select Y (for yes) to list rules for which conflicts exist or N (for 
no) to list rules for which conflicts do not exist. Or leave the parameter blank to 
list both types of rule. 

• End Dated Conflict: Select Y (for yes) to list rules for which conflicts are end-
dated or N (for no) to list rules for which conflicts are not end-dated. Or leave 
the parameter blank to list both types of rule. 

• Same OU: Select Y (for yes) to list rules that apply within operating units or N 
(for no) to list rules that apply across operating units. Or leave the parameter 
blank to list both types of rule. 

• Same SOB: Select Y (for yes) to list rules that apply within sets of books or N 
(for no) to list rules that apply across sets of books. Or leave the parameter blank 
to list both types of rule. 

The Conflict Matrix Report looks like this: 
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Application Conflict Report 
The Application Conflict Report lists conflict rules and, for each, provides status 
information about each user affected by the rule —  whether the conflict has been 
accepted or rejected or remains pending, and the start and end dates that apply to an 
approval decision. As you generate the report, you can select the following parameters: 

• Snapshot Run Date: Select a date to view summary values for conflicts generated 
up to that date. This parameter is required. 

• Application Name: Select an application to view information about rules that 
involve that application, or leave the parameter blank to view rules that involve 
any application. 

• Conflict Rule Name: Select a conflict rule to view information only about that 
rule. Or leave this parameter blank to see information about all rules. 

• Entity Type: Select Function or Responsibility to view information about rules 
that find conflicts in one entity or the other, or Both to see information about 
both types of rules. 

• Control Type: Select a control type — Approval Required, Allow with Rules (with 
Approval), Allow with Rules, or Prevent — to view information on conflict rules of 
that type. Or accept the default, All, to see information on conflict rules of all types. 

• Approval Status: Select Approved, Pending, or Rejected to see information about 
conflicts at one of these statuses, or retain the default value, All, to see 
information about conflicts at all statuses. 

The Application Conflict Report looks like this: 
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User Exclusions Report 
The User Exclusions Report lists all of the persons who have been granted exemp-
tions for conflict-rule processing. Typically these are people, such as support person-
nel, who might require substantial super-user access, but who do not actually carry 
out the responsibilities or functions that are in conflict. Such users would therefore 
generate many user conflicts even though the conflicts need not be tracked. The 
User Exclusions report does not take any parameters, and looks like this: 

 

Extract Conflict Rules 
The Extract Conflict Rules concurrent request generates a CSV (text) file that 
contains a record of each active conflict rule — each rule that is not end-dated. The 
file can then be used for uploading conflict rules into another Oracle Applications 
instance. The Extract Conflict Rules request takes no parameters, and it produces 
output looks like the following: 

 
Save the output as a CSV file in order to upload it to another instance. 
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Load Conflict Rules 
The Load Conflict Rules concurrent request uploads conflict-rule definitions from a 
CSV file. That file is generated either by the Extract Conflict Rules concurrent request 
or from a spreadsheet provided by LogicalApps. For a detailed procedure for using 
the Load Conflict Rules concurrent request, see page 13.  

Archive User Conflict Data  
The Archive User Conflict Data concurrent request archives records of older con-
flicts to a history table. This request takes, as its only parameter, a date in the format 
configured for your instance of Oracle Applications; the request archives conflicts 
generated before that date. 

Reset User Conflicts 
The Reset User Conflicts concurrent request in effect rescinds the assignment of con-
flicting responsibilities to a user. Ordinarily, such a conflict would be approved (and 
end dates for the responsibilities would be removed) or rejected (and end dates retained). 
Until then, however, the user has no access to the responsibilities and the assignment 
cannot be changed. If the approval decision is never made (if, for example, the desig-
nated reviewer leaves the company), the Reset User Conflicts request can be run so 
that the user’s assignments are returned to their original state, and the assignment 
can be made again (with the conflict rule rewritten to designate another reviewer). 
The request takes, as its only parameter, the user ID of the user whose conflicts are 
to be reset. 

Analyze Responsibility Conflicts 
The Analyze Responsibility Conflicts concurrent request runs conflict rules in order 
to reduce conflicts to the responsibility level. That is, before function conflicts can 
be recognized as applying to users, they must be recognized as existing in the respon-
sibilities that are assigned to users. The Analyze Responsibility Conflicts request per-
forms this step; running this request therefore speeds the process of generating user 
conflicts. This request takes no parameters. 

Generate User Conflicts 
The Generate User Conflicts concurrent request analyzes the assignments of respon-
sibilities to users and determines which assignments violate conflict rules. Running 
this concurrent request is equivalent to clicking the Generate User Conflicts button 
in the Conflict Matrix form (see page 17). This request takes no parameters. 
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Cache WF User Roles 
The Cache WF User Roles request refreshes a table called laa_wf_user_roles, which 
holds workflow-role data used only by AppsAccess. Typically you need not run this 
request, because equivalent processing occurs each time user conflicts are generated, 
either through use of the Generate User Conflicts button (see page 17) or the Gener-
ate User Conflicts concurrent request (see above). You may, however, choose to run it 
when a reviewer is updated in an AppsAccess rule or when there is an update to work-
flow roles used as AppsAccess reviewers 
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